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Versionner & DéployerVersionner & Déployer
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→ Suivre l'évolution des �chiers

→ Faciliter le développement collaboratif

→ Revenir à une version précédente

Pourquoi versionner ses projets ?
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Git : concepts et vocabulaire (1/2)
repository : dépôt. Un dossier contenant tous les fichiers d'un projet ainsi que l'historique de révision. Un dépôt
peut être personnel ou partagé. Il peut être public ou privé. Il peut être local ou distant (remote).

commit : révision. Modification d'un ou plusieurs fichier du dépôt. Lorsque vous effectuez un commit pour
enregistrer votre travail, Git crée un identifiant unique (SHA) qui vous permet de garder une trace des
modifications spécifiques réalisées ainsi que de leur auteur et de leur date. On associe généralement un court
descriptif à un commit.

branch : enchaînement de commit. Les branches permettent de faire des développements parallèles qui
n'affectent pas les autres branches.

main : branche de développement par défaut. Les projets historiques utilisent le terme master.

HEAD : commit le plus récent, à la tête de la branche.
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Git : concepts et vocabulaire (2/2)
clone : Copie local d'un dépôt. Le dépôt cloné est toujours connecté à la version distante de sorte qu'il soit
possible de synchroniser facilement (push/pull/...).

pull : récupérer les commits distants et les fusionner avec la version locale.

push : pousser ses commits vers un dépôt distant, afin que d'autres puissent y accéder. Permet également
d'assurer une sauvegarde distante.

merge : fusion. Appliquer les commits d'une branche à une autre branche. Si il y a des conflits, il faut les résoudre
avant la fusion.

checkout : changer de branche de travail actuelle. Permet de changer de branche ou bien de revenir à une
version antérieure.

staging area : index. Espace de travail qui servira de base pour le prochain commit.

Happy Git and GitHub for the useR

GitHub Docs
GitHub cheat-sheet
Git cheat-sheet (ndpsoftware)
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Git �ow
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Démo
1. Création d'un dépôt avec GitLab

2. Clone avec RStudio

3. Modi�cation et commit

4. git pull / git push
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Cloner un projet :
File > New Project > Version Control >
Git > URL (SSH ou HTTPS)

Initier un projet

usethis::use_git()

Personaliser son git config

usethis::use_git_config(user.name = "Jane", u

Générer un .gitignore

usethis::git_vaccinate()

Conseils pour utiliser git avec R (et RStudio)

8 / 37



rmarkdown permet de regrouper de créer
dynamiquement des documents comprenant du code,
des résultats (tel que des plots) et de la prose (les
commentaires et explications).

Ceci est utile pour :

Faire des analyses de DataScience de manière
interactive (avec RStudio par exemple)
Reproduire ses analyses
Collaborer et partager son code
Communiquer ses résultats à des collègues pas
nécessairement à l'aise avec R.

Les métadonnées du documents sont regroupées dans
un en-tête YAML.

Les documents R Markdown peuvent être compilés en
HTML, PDF, ...

On utilise l'extension .Rmd ou .rmd.

 

Rédiger un document avec R Markdown

R Markdown Cookbook

R Markdown: The Definitive Guide
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Démo
1. Création d'un document (dans notre dépôt Git)

2. RStudio visual editor

3. Code chunks

4. Ajout de tables avec kable et DT

5. Ajout d'une table des matières (toc: true)

6. Bloc de code en python (nécéssite des packages dédiés)

7. Knit pour exporter en HTML
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Avec GitLab Pages, on peut publier facilement des
sites web statiques directement à partir d'un dépôt
GitLab.

Il suffit d'ajouter un template d'intégration continue
(CI/CD pipelines).

Pour chaque modification poussée sur le dépôt, GitLab
CI/CD exécute le pipeline qui publie immédiatement les
modifications sur le site.

Possibilité d'ajouter un domaine dédié en .inrae.fr
(ou autre)

⚠  Si <user> comprend un point ., celui-ci sera
considéré comme un sous domaine double. N'ayant
pas de certificat dédié, le navigateur demandera une
exception de sécurité. (par exemple cedric.midoux)

Démo
Sur GitLab :

1. Ajouter un nouveau fichier Add(+)
2. Sélectionner un template .gitlab-ci.yml
3. Appliquer le template Pages - HTML
4. Commit

Les paramètres généraux sont disponibles dans
Settings > Pages

Les paramètres de visibilité sont à détailler dans
Settings > General > Visibility

Les fichiers sont accessibles à
https://<user>.pages.mia.inra.fr/<repos>/<file>.html

Partager un HTML grace aux GitLab Pages
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Packager une application ShinyPackager une application Shiny
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Packager une appli dans un package pour :
Automatiser ce qui est automatisable
Travailler avec des outils fiables
Gagner du temps de développement
Simplifier le déploiement
Standardiser le travail en équipe

→ Application Shiny dans un package

Application découpée en fonctions / modules
Application testée
Application avec des dépendances explicites
Application documentée
Application disposant de métadonnées

golem - Concepts
golem est un framework qui permet de créer, maintenir et déployer facilement une application Shiny.

golem, YouTube et Cheatsheet
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https://thinkr.fr/golem_cheatsheet_v0.1.pdf
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golem - Structure
golem::create_golem(path = "~/appdemo")

.

├── DESCRIPTION                # Métadonnées

├── NAMESPACE                  # Fonctions exportées et celles importées

├── R                          # Fonctions

│   ├── app_config.R           #

│   ├── app_server.R           # Remplace la partie server de l'appli

│   ├── app_ui.R               # Remplace la partie ui de l'appli

│   └── run_app.R              # Lance l'application

├── appdemo.Rproj              # R Projet

├── dev                        # Dossier de développement

│   ├── 01_start.R             # Script d'initialisation

│   ├── 02_dev.R               # Script de développement

│   ├── 03_deploy.R            # Script de déploiement

│   └── run_dev.R              # Exécuté par golem::run_dev() pour visualiser l'appli
├── inst                       

│   ├── app                    
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Démo
1. Création d'un projet golem

golem::create_golem(path = "~/appdemo")

2. golem::run_dev() lance l'appli

3. Édition de l'interface dans app_ui.R

4. Install and Restart

5. Notre appli est un package qui lance l'appli avec appdemo::run_app()
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dev/01_start.R: initialisation de l'appli
Fonctions à lancer (ou pas) début du projet

golem::fill_desc(): remplir le fichier DESCRIPTION
golem::set_golem_options(): mise à jour de inst/golem-config.yml
golem::use_recommended_tests(): mise en place de tests unitaires
golem::use_recommended_deps(): ajout de dépendances

Fonctions issues de usethis:

usethis::use_mit_license( "Golem User" ) , usethis::use_gpl3_(), ...
usethis::use_readme_rmd( open = FALSE )

usethis::use_git()
...

Autres fonctions à utiliser en connaissance de cause

golem::use_utils_ui() et golem::use_utils_server(): fonctions utilitaires d'aide au développement 16 / 37



dev/02_dev.R: le développement quotidien
Modularisation de l'appli: shiny modules

Permettent de découper l'application en petites unités
Composés d'une partie server et d'une partie ui
Permettent de rappeler ces fonctions à plusieurs endroits de l'application
Ils s'assurent de l'unicité des ID, les identifiants doivent être spécifiés dans des ns()

Colin 
@_ColinFay · Follow

Reminder that 99% of cases, the reason why your 
shiny module is not rendering is because you forgot 
a ns()
8:28 AM · Nov 22, 2021

Read the full conversation on Twitter

47 Reply Copy link

Read 3 replies
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mod_dice_ui <- function(id) {

  ns <- NS(id)

  tagList(

    sliderInput(inputId = ns("nb"),

      label = "Combien de dés ?",

      min = 1, max = 10, value = 2, step = 1

    ),

    verbatimTextOutput(ns("tirage"))

  )

}

mod_dice_server <- function(id) {

  moduleServer(id, function(input, output, se

    ns <- session$ns

    output$tirage <- renderPrint({

      sample(6, size = input$nb, replace = TR

    })

  })

}

Démo : module "lancer 1 à 10 dés 6"
Création du module: golem::add_module( name = "dice" )

## To be copied in the UI
# mod_dice_ui("dice_1")

## To be copied in the server
# mod_dice_server("dice_1")
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Les tests

devtools::check()

Construction du package .tar.gz

devtools::build()

En local

remotes::install_local()

Avec RStudio

golem::add_rstudioconnect_file()

golem::add_shinyappsio_file()

golem::add_shinyserver_file()

Avec Docker

golem::add_dockerfile()

golem::add_dockerfile_shinyproxy()

dev/03_deploy.R: le déploiement

golem, YouTube et Cheatsheet
Engineering Production-Grade Shiny Apps
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https://thinkr-open.github.io/golem/
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Tour d'horizon de packages R à (re)découvrirTour d'horizon de packages R à (re)découvrir
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Le tidyverse est une collection de packages R
conçus pour la DataScience. Tous les packages
partagent une philosophie de conception, une
grammaire et des structures de données sous-
jacentes.

Core tidyverse:

ggplot2 : visualiser les données
dplyr : manipuler les données
tidyr : mettre en forme les données
readr : importer les données
purrr : itérer des fonctions sur les données
tibble : version moderne des data-frames
stringr : manipuler de chaînes de caractères
forcats : manipuler des facteurs

Le tidyverse comprend également de nombreux autres
packages avec une utilisation plus spécialisée.

Tidyverse et R4DS

tidyverse, l'incontournable
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tidyverse, l'incontournable
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fusen permet de créer un package à partir de fichiers
RMarkdown avec une philosophie «Rmd-first».

Dans le template rmarkdown on décrit la
description puis pour chaque fonction :

les chunks function
les chunks example
les chunks tests
les chunks development

fusen::inflate() se charge du reste ...

Intégration des tests de développement (avec
testthat), de la création de vignette, de la
construction du site avec pkgdown et des outils de
développement (devtools et usethis).

fusen et blog

fusen, le développeur
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renv permet une gestion fine des versions des
packages au sein de chaque projet.

Les projets seront isolés (l'installation ou la mise à jour
d'un package n'a pas d'effet sur les autres projets),
portables (renv facilite l'installation des packages
dont dépend votre projet) et reproductibles (renv
enregistre les versions des packages dont le projet
dépend).

Particulièrement adapté à une utilisation avec git.

Petit bonus, les packages ne sont pas installés dans le
dossier de mon projet mais sont partagés avec un lien
symbolique dans un dossier renv/cache/ qui contient
les différentes versions des packages.

renv et slides

Initialisation d'un nouvel environnement local pour
le projet avec une bibliothèque privée

renv::init()

Installation des packages comme d’habitude

install.packages(...)

Sauvegarde de l'état de la bibliothèque privée du
projet. Les packages utilisés et leur version sont
détaillés dans le fichier renv.lock

renv::snapshot()

Si besoin, restaurer les versions tel-que détaillées
le fichier de verrouillage

renv::restore()

renv, le manager de packages
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targets est un gestionnaire de pipelines "make-
like" pour les statistiques et DataScience.

On définit les cibles et target déduit les relations
entre les morceaux du projets. Il n'exécute que les
calculs nécessaire.

Visualisation :

targets, book et YouTube

_targets.R :

library(targets)

library(tarchetypes)

source("R/functions.R")

options(tidyverse.quiet = TRUE)

tar_option_set(packages = c("biglm", "dplyr",

list(

  tar_target(

    raw_data_file,

"data/raw_data.csv",

    format = "file"

  ),

  tar_target(

    raw_data,

    read_csv(raw_data_file, col_types = cols(

  ),

  tar_target(

targets, le ciblé
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Pour permettre à la communauté de nous aider il est
souvent utile de fournir un exemple reproductible. Le
code doit être le plus court possible et contenir toutes
les dépendances. Si possible utiliser des jeux de
données présents dans R (iris, mtcars, ...). De
même, faciliter la lecture avec styler.
On peut ainsi reproduire le problème rencontré dans
une nouvelle session R.

reprex génère un exemple reproductible à partir du
code présent dans le clipboard pour vous permettre de
demander facilement de l'aide à la communauté.

L'exemple est exécuté dans un rmarkdown et le
résultat rendu dans le presse-papiers de l'utilisateur.

Divers formatages de sorties sont disponibles (R,
Issues Github, Slack, Stack Overflow, ...) ainsi que
l'ajout des informations de session_info.

reprex

library(tidyverse)

summary(iris$Species)

#>     setosa versicolor  virginica 
#>         50         50         50
ggplot(data=iris, aes(x = Sepal.Length, y = S

  geom_point(aes(color=Species, shape=Species

  xlab("Sepal Length") +  ylab("Sepal Width")

  ggtitle("Sepal Length-Width")

reprex, l'exemplaire
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pins permet "d'accrocher" et de publier des données,
des modèles et d'autres objets R. Ceci permet de
partager des objets R entre projets et entre
collaborateurs.

Les objets sont accrochés sur des boards qui peuvent
être des dossiers (partagés ou non) ou des services tel
que RSConnect, Amazon, Microsoft365, ...

Le suivi des versions des objets épinglés est facilité.

API moderne dédiée.

Création d'un board :

board <- pins::board_temp()

# board <- pins::board_local() # share data a
# board <- pins::board_folder("~/Dropbox") # 
# board <- pins::board_folder("Z:\\my-team\pi

pins

board

## Pin board <pins_board_folder>

## Path: 'C:/Users/CEDRIC~1.MID/AppData/Local/Temp/Rt

## Cache size: 0

Attacher un objet au board :

pins::pin_write(board, iris, name = "fleurs")

## Guessing `type = 'rds'`

## Creating new version '20220207T141419Z-f2bf1'

## Writing to pin 'fleurs'

Lire un objet du board :

pins::pin_read(board, "fleurs") %>% identical

## [1] TRUE

pins, l'attachant
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pagedown

bookdown facilite la rédaction de livres, de
documentation d'outils et documents longs.

Générer des livres et des ebooks prêts à imprimer
Un langage de balisage plus facile à prendre en
main que LaTeX
Formats de sortie variés: PDF, LaTeX, HTML,
EPUB ou Word
Possibilité d'inclure des graphiques dynamiques et
des applications interactives (Shiny)
Prise en charge de langages autres que R,
notamment C/C++, Python, SQL, ...
Peut être publié sur GitHub, GitLab, bookdown.org

Intégration à RStudio : File > New Project > New
Directory > Book project using bookdown

puis Build Book > bookdown::gitbook

Voir aussi pagedown pour créer des
documents HTML paginés pour
l'impression à partir de R Markdown.

bookdown: Authoring Books and Technical
Documents with R Markdown

bookdown, le rédacteur
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rticles fourni des templates pour faciliter la rédaction
d'articles scientifiques avec R Markdown et LaTeX.

rticles::journals()

##  [1] "acm"            "acs"            "aea"           

##  [4] "agu"            "ajs"            "amq"           

##  [7] "ams"            "arxiv"          "asa"           

## [10] "bioinformatics" "biometrics"     "copernicus"    

## [13] "ctex"           "elsevier"       "frontiers"     

## [16] "glossa"         "ieee"           "ims"           

## [19] "jasa"           "jedm"           "joss"          

## [22] "jss"            "lipics"         "mdpi"          

## [25] "mnras"          "oup_v0"         "oup_v1"        

## [28] "peerj"          "pihph"          "plos"          

## [31] "pnas"           "rjournal"       "rsos"          

## [34] "rss"            "sage"           "sim"           

## [37] "springer"       "tf"             "trb"           

## [40] "wellcomeor"

rticles

Les templates sont disponibles avec File > New
File > R Markdown > From Template

rticles, l'auteur
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workflowr permet d'organiser les analyses pour
une gestion de projet efficace, une meilleure
reproductibilité, une bonne collaboration et partage des
résultats. Ce package promet :

un modèle de projet avec une organisation en
sous-dossiers
des templates R Markdown dédiés
une intégration du versionning avec git
une exécution de chaque analyse dans une
session R isolée
un suivi des informations de session
la création d'un site web dédié à chaque analyse
pour présenter les résultats et hébergeable avec
GitLab Pages.

workflowr et démo et YouTube

library("workflowr")

# Configure Git (only need to do once per com
wflow_git_config(user.name = "Full Name", use

# Start a new workflowr project
wflow_start("myproject")

# Build the site
wflow_build()

# Customize your site!
#   1. Edit the R Markdown files in analysis/
#   2. Edit the theme and layout in analysis/
#   3. Add new or copy existing R Markdown fi

# Preview your changes
wflow_build()

# Publish the site, i.e. version the source c
wflow_publish("analysis/*", "Start my new pro

workflowr, l'organisé
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https://workflowr.github.io/workflowr/
https://stephenslab.github.io/wflow-divvy/
https://youtu.be/O1wv94sZfvE


xaringan permet de créer des diaporamas avec
remark.js et R Markdown.

remark.js gère la mise en forme des slides, la
présentation et les raccourcis clavier.

R Markdown (knitr) permet d'ajouter des calculs et
résultats dynamiques à un simple markdown.

Intégration d'un addin Infinite Moon Reader pour
une preview en direct des slides dans RStudio.

De nombreux thèmes et possibilité d'ajouter un CSS (si
vous arrivez à récupérer celui d'INRAE, ça m'intéresse)

xaringan a permis de faire ces slides (et elles sont mise
à dispo grâce à GitLab CI/CD)

xaringan et slides

Particulièrement adapté aux formations R : DataTable

DT::datatable(iris, rownames = FALSE, 

              options = list(scrollX = TRUE, 

xaringan, le présentateur

Previous 1 2 3 4 5 …

30 Next

Sepal.Length Sepal.Width Petal.Length P

5.1 3.5 1.4

4.9 3 1.4

4.7 3.2 1.3

4.6 3.1 1.5

5 3.6 1.4
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https://bookdown.org/yihui/rmarkdown/xaringan.html
https://slides.yihui.org/xaringan/


Particulièrement adapté aux formations R :

Un plot dynamique

library(ggplot2)

library(ggiraph)

library(palmerpenguins)

gg_point <- ggplot(data = penguins) +

  geom_point_interactive(

    aes(

      x = flipper_length_mm,

      y = body_mass_g,

      color = species,

      tooltip = island

    )

  ) +

  theme_minimal()

girafe(ggobj = gg_point)

xaringan, le présentateur
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learnr permet de rédiger un tutoriel interactif à
partir de R Markdown. Les tutoriels peuvent
comprendre :

Du texte, des figures, des plots, des équations
Des exercices de code (chunck R que l'utilisateur
peur modifier et exécuter directement)
Des quiz
Des vidéos (hébergées sur YouTube)
Des composants Shiny

learnr

---

title: "Hello, Tutorial!"

output: learnr::tutorial

runtime: shiny_prerendered

---

```{r setup, include=FALSE}

library(learnr)

```

The following code computes the answer  

to 1+1. Change it so it computes 2+2:

```{r addition, exercise=TRUE}

1 + 1

```

learnr, le pédagogue
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https://rstudio.github.io/learnr/


distill permet de créer des sites web à partir de R
Markdown. Il a été optimisé pour les « communications
scientifiques et techniques ».

Initialisation du projet parmi deux structures
disponibles : website et blog :

distill::create_website(dir = "mysite", title

Création de _site.yml pour la configuration,
index.Rmd pour la page principale,
_posts/welcome/welcome.Rmd la première page
du site.

Ajout de nouveau post:

distill::create_post("Un nouveau post")

Les articles sont créés dans le dossier _posts.

Construction de l'article avec Knit.

Construction du site avec l'onglet Build
Website

rmarkdown::render_site()

Mise à disposition, soit via un HTML standalone,
soit via RPubs, soit avec GitLab Pages.

Comme les autres R Markdown, les pages prennent en
charge textes, images, plots, tables, équations,
bibliographie, footnotes, toc, blocs de code, thème CSS
...

distill, le blogueur

Voir aussi blogdown pour créer des sites
web avec HUGO.

distill for R Markdown
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https://pagedown.rbind.io/
https://pagedown.rbind.io/
https://rstudio.github.io/distill/


Exemples de productions MIGALE

Slides de formations avec xaringan

Blog Tutorials avec blogdown et HUGO

Rapports d'analyses avec rmarkdown (mais pas de projets publics)

Tutoriels d’annotation de génomes du CATI BOOM avec bookdown
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https://formations.migale.inrae.fr/Comparative_Genomics/slides.html
https://tutorials.migale.inra.fr/
https://cati-boom.pages.mia.inra.fr/boom-annot/annotation/index.html


Pour aller plus loin
• Les di�érents livres et sources présentés dans ces slides.

• Suivre des sujets tel que #RStats, #tidyverse, #R4DS, #TidyTuesday ou les grands noms de la
communauté sur Twitter.

• Suivre les blogs de R Project, rOpenSci, ThinkR (vf ), RStudio et Tidyverse.

• Aller aux di�érents évènements : The useR! Conference et Rencontres R.

• Conférence de Maëlle Salmon : S'il-vous-plaît... dessine-moi un projet (slides) et Projet PROPRE
(PROcessus de Publications REproductibles) de Sébastien Rochette.

• Commencer par un petit projet, seul ou en équipe. Mettre en pratique petit à petit les di�érents
éléments. Rester informé des nouveautés. Ne pas avoir peur de changer d'outils au �l du temps.
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https://twitter.com/rstatstweet
https://twitter.com/tidyversetweets
https://twitter.com/R4DScommunity
https://twitter.com/hashtag/TidyTuesday
https://developer.r-project.org/Blog/public/
https://ropensci.org/blog/
https://thinkr.fr/blog/
https://www.rstudio.com/blog/
https://www.tidyverse.org/blog/
https://user2022.r-project.org/
https://paris2021.rencontresr.fr/
https://youtu.be/nc5w1ROsP3A
https://rr2021.netlify.app/
https://rdes_dreal.gitlab.io/publication_guide/production/index.html#quest-ce-quun-projet-collaboratif-propre


Merci de votre attention !!

 

cedric.midoux@inrae.fr
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